
CD E
ncl

ose
d 

Susan Hussey Bush 

Enhance Your DesktopDesktop App! 
More Desktop Features Made Easy 

Alpha Anywhere 

Also suitable for Alpha Five V11 



 

 Web Wonders Dazzle Desktop! — Learn to create your first grid component and use it on 

the desktop. Great way to sample the web side of the software. 

 Picture Perfect! — Your database will stand out when you add images, charts and even 

Google Maps! 

 Data Entry Made Easy! — Learn about data controls and which to use when for easier and 

more accurate data entry.  Zoom, zoom from an embedded browse to an entry form. 

 Radical Reports! — Add charts, bookmarks, table of contents, index and color to make your 

reports real crowd pleasers.  

 Find It! Sort It! Filter It! — Work your way through the many find, sort and filter features. It’s 

all about making it easy for the end user. 

 Experiment with Xbasic and Xdialog! — Even a non-programmer will be impressed with 

these mind broadening exercises. 
 Customize Your App! — Design your own menus and toolbars and show the progress of a 

long script. See some neat new ways to use Bubble Help. 
 Hot Color and Cool Style! — Consistent design is easy when you know how to use color and 

style. 

 Exciting Email and Efficient Faxes! — Learn how to make an email confirmation that you 

can send with a click.. Need to fax a report? Do it from within the program. Alpha Mailer uses your 
tables to send mass emails. 
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Expand your ability with these books…

Alpha Five Web & Mobile Made Easy
by Susan Hussey Bush

Make the most of your software — your copy of comes
with the ability to design Web & Mobile applications. The
way of today - don’t miss out!

•Two volumes.

Alpha Five: Xbasic for Everyone
by Dr. Peter Wayne

Learn Xbasic, Alpha Anywhere’s programming 
language. Hard copies and downloads available at 
www.LibertyManuals.com.

Alpha Anywhere
Made Easy

by Susan Hussey Bush

The perfect book for learning how to use Alpha Anywhere for
the desktop. Learn to create your own application and will be
ready to add the features you learn here. A must have for all

Alpha Anywhere desktop devotees.

Alpha Five Functions Handbook, 
Functions and Expressions Made Easy
by Susan Hussey Bush

Alpha Five’s Functions allow the development of database
applications with and without programming. In this handbook,
they are explained simply, in layman’s terms. This manual was
born of the author’s many years of frustration while searching
for the right function for the job. Character, date, numeric, sum-
mary or filter—you’ll find and use them easily in this logically
designed manual.

•Also suitable for Alpha Anywhere.

http://www.LibertyManuals.com
http://www.libertymanuals.com/web-applications/version-10-1.html
http://www.libertymanuals.com/xbasic-for-everyone-v8/version-8-and-later.html
http://www.libertymanuals.com/functions-handbook/version-5-and-later.html
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Frances M. Peake, professional database developer, has this to say about 
Alpha Anywhere Made Easy…

Susan Bush and I met at the Alpha Five*

Developer’s Conference in December of 2000. I was
the professional developer. Susan used Alpha Five in
her business. After a short conversation with Susan, I
realized that she was much more than an end-user.
She has made a study of Alpha Five over the years,
pushing the product to its limits to serve her business
needs. 

Shortly after the conference, Susan came to our
South Florida Database User Group meeting. She
offered to give a presentation on a multi-step import
procedure she had devised in Alpha Five. She
impressed the group with detailed handouts and
screen shots. Then she hosted the next few meetings
while I was out of town. 

When I returned to the User Group meetings,
Susan pitched the idea of doing a seminar to help

Alpha Four† users make the transition to Alpha Five
thus our joint ventures, “Get Outta DOS” and then
“Get into Alpha Five!” seminars were born. We
agreed that, with all the preparation it would require,
the seminars would not be big money makers. So I
asked, “What would you want to get out of it?” She
stated very emphatically, “I want to do an Alpha Five
book.” I can’t remember whether I said this out loud,
but my first thought was “Are you out of your
mind?” But I knew it was true, Susan was going to
write her Alpha Five book.

The book that you hold in your hands is not
simply the product of Susan’s experience as an
advanced-level Alpha Five user. It is a product of her
vision and seemingly boundless energy and enthusi-
asm. It is also a product of many, many hours of

research, writing, editing and above all, attention to
detail. 

Like so many of us in the Alpha Five commu-
nity, Susan saw a need for additional training and
support materials for Alpha Five. Any of us who
have ever contemplated actually writing such a book
and imagined ourselves as the author of, “Step 1.
Right-click the mouse…Step 2. Choose Proper-
ties…” can only begin to appreciate what Susan has
accomplished here. 

This book can be used as both a tutorial and
reference manual. Susan has achieved a healthy and
practical balance between tutorial and reference by
offering short, compartmentalized exercises. The
book and disk that accompanies it are designed so
that you can start at any chapter. For example, if you
want to jump right into designing forms, you will not
be lost if you have not followed the lessons from
Chapter 1. You will find that every chapter is chock-
full of valuable information for Alpha Five users of
all levels.

The value of Susan’s experience using Alpha
Five in a real-world business environment cannot be
overstated. It is evident throughout the book in the
plain-English explanations of each Alpha Five fea-
ture and in the examples she uses. You will appreci-
ate the generous use of screen shots to guide you
through the exercises. Best of all are the tips and
hints she provides to help shorten the learning curve
so that you can get the most out of Alpha Five.

On behalf of Alpha Five users and enthusiasts
everywhere, thank you Susan, for writing this book!

— Frances M. Peake,‡ Co-owner, Proctor & Peake, Inc.
www.proctorandpeake.com

*. Alpha Anywhere is powered by Alpha Five V12, so references are suitable to both products.

†. Alpha Four is a relational database program developed by Alpha Software, Inc. It uses the MS DOS platform.

‡. Frances Peake is the author of Alpha Four to Alpha Five, The Transition, soon to be available at www.proctorandpeake.com and 
www.libertymanuals.com



About the author

  From her first computer experi-
ence in 1984 – a used Apple I presented by her
father after he upgraded to an Apple II – Susan
Hussey Bush has been hooked on this amazing
(and sometimes frustrating) tool of the modern
world. The 1985 purchase of the state of the art
IBM XT with an astounding 10 mg hard drive
opened the door to database development. That
first flat database, Nutshell, showed her that one
did not have to be a programmer to develop
applications.

Later, she began the search for a relational
database that did not require programming skills.
Alpha Four, a DOS product, met those require-
ments. When Alpha Five was released, she

moved to the Windows version and developed a
database for her business, Liberty Food Market-
ers Co. She has since sold the business to her
son, who continues to uses the database to stay
current with the demands of government bidding
and to offer customers outstanding service.

Susan’s first Alpha book was for Alpha Five
v4.5. She has written updates for every version
since. She always welcomes new features and
looks forward to working out ways to explain
them in her unique step-by-step exercises.

She feels the name change from Alpha Five to
Alpha Anywhere was a natural because it
describes the range of desktop, web and mobile
applications that are essential to today’s markets.

Susan has a Bachelor of Fine Arts in Archi-
tectural Design. She brings that training to her
application designs and to her books

She lives with her husband, Richard, in Flat
Rock, North Carolina. They take great pleasure
in their blended family of seven children and
eight grandchildren, spread across the country.
Mike, Liz and Walter Hussey live in the Florida
Keys. JR Hussey and his wife, Carin Young, live
in Mill Valley, CA. In Oakhurst, New Jersey,
Dave Hussey keeps busy with Liberty Food
Marketers Co. and acts as fulfillment manager
for Liberty Manuals Co. Rick Bush lives in Mis-
souri. His eldest daughter, Hailey, is in Joplin,
Missouri and younger daughters, Jordan and
Lindsey, are in Pea Ridge, Arkansas. Jordan
recently added baby Beckett to the clan. Ross
Bush and daughter, Clara, live in Vichy, Mis-
souri. Residing in Fort Smith, Arkansas are
Missy, her husband, Jeff Brown and son Jake.
Kathleen and Sands Orris and their sons, Wil-
liam and Foster make their home in Cumming,
Georgia.



This book is dedicated to my husband, Richard Bush,

my son, J. R. Hussey and his wife, Carin Young
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San Francisco photos (jrhussey.com). 

Carin’s hobbies are horses and photography. She is also excited 
about her company, Matterhorn Social Media (www.matterhorn-
company.com). 

They both enjoy skiing and, of course, their Yorkie, Henry.
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ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
Introduction

Alpha Anywhere & Alpha Five

This manual is for those who have experience with
Alpha Anywhere or Alpha Five, so we know you are
already a fan of this remarkable software. As each new
feature is added, we become more and more impressed at
what can be done with such facility.

And, regardless of the degree of sophistication that the
program itself may achieve, it continues to appeal to pro-
grammer and non-programmer alike. And that’s a big deal

in our book.*

A message to the small business 
community
 The database is a wonderful tool, yet, unfortunately,

many small business owners believe they must know how
to write code in order to create database applications.

Alpha Anywhere / Alpha Five has been our solution for
many years.

I am a business owner, not a programmer, yet I
designed the databases which have been the foundation of
my companies for many years. You’ve heard it said repeat-
edly, “If I can do it, you can do it.” 

And it is true. I did. You can. Good Luck—and have
fun!

—Susan H. Bush

President, Liberty Manuals Company

Books for desktop design

Liberty Manuals has four books that are essential to
learning to design desktop applications.

Here’s what you’ll find in them:

Alpha Anywhere Made Easy!
This is the place to begin.

In just a short time, you will
have a basic understanding of
the program and will soon be
developing your own custom
application. 

• Chapter 1: Planning Ahead

• Chapter 2: Workspaces and 
Tables

• Chapter 3: Alpha Anywhere 
with SQL

• Chapter 4: The Alpha Help 
System

• Chapter 5: Field Rules and Data Entry

• Chapter 6: Sets and Mapped Tables

• Chapter 7: Forms and Browses

• Chapter 8: Introduction to the Web

• Chapter 9: Introduction to Mobile

• Chapter 10: Operations

• Chapter 11: Buttons, Hyperlinks & Bubble Help

• Chapter 12: Inserting Images

• Chapter 13: Handy Things to Know

Enhance Your Desktop App!
This is the book that belongs
at your side while you are
developing your own applica-
tion. It contains methods you
might not have previously
considered and will expand
your working knowledge of
others. 

•Chapter 1: Beyond the Basics!

•Chapter 2: Web Wonders 
Dazzle Desktop!

•Chapter 3: Picture Perfect!

•Chapter 4. Data Entry Made Easy!

•Chapter 5: Radical Reports!

•Chapter 6. Find it! Sort it! Filter it!

•Chapter 7: Experiment with Xbasic & Xdialog!

*. No pun intended!
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INTRODUCTION
Getting Started
•Chapter 8: Customize Your App!

•Chapter 9: Hot Colors and Cool Styles!

•Chapter 10: Exciting E-mail and Efficient Faxes!

•Chapter 11: Heavenly Help Plus

Alpha Anywhere Report Writer!
Reporting and charting are definitely
made easy with this book. This book
is the third in the desktop series. It is
also applicable to web and mobile

apps.*

Alpha Five Functions Handbook!
The Alpha Five Functions Hand-
book details more than two hundred
commonly used functions and
explains how they are used in
expressions.

•Also suitable for Alpha Anywhere.

In addition to the above “must
haves,” there are some more books
that will aid in your study. All are

available at www.libertymanuals.com.

Learning Xbasic
Alpha Anywhere and Alpha Five

contain the tools that allow you to
design databases with or without
using code. For those interested in
learning Xbasic, a good starting
point is Dr. Peter Wayne’s book,
Alpha Anywhere Xbasic Workbook.

• Also suitable for A5 V11.

Alpha Four to Alpha Five: The Transition 
If you still are still running an Alpha Four database,

this guide will make the transition to Alpha Anywhere /
Alpha Five go more smoothly. It is written by Frances
Peake, professional Alpha Five & Alpha Anywhere devel-
oper. Go to www.libertymanuals.com and click Contact
Us to request a free copy.

Integrating Desktop with Web/Mobile
Your copy of Alpha Five comes
complete with the ability to develop
web and mobile applications. As you
will learn in Chapter 2, web forms
can also be used on the desktop. To
learn more about creating web com-
ponents, be sure to get Alpha Any-
where Web & Mobile Made Easy,
Volumes 1 and 2.

• A5V11 users get Alpha Five Web Applications Made 
Easy, The Basics and More for V11.

Hard copies and downloads
We carry both electronic download editions and hard

copies of all our books. The hard copy editions are pro-
duced in full color with a durable spiral binding for conve-
nience in learning and future reference. If you have
purchased this book as a download and now want the hard
copy, go to www.libertymanuals.com and click Contact Us
to discuss an appropriate credit.

More Learning Tools
Liberty Manuals is constantly adding to its library, so

be sure to check out all the books at www.libertymanu-
als.com.

Acknowledgments
The assistance of my son and fulfillment manager,

David Hussey continues to be invaluable. Dave handles
the printing, assembly and shipping of our books.

Getting Started

About Enhance Your Desktop App!
Enhance Your Desktop App! was developed to aid

intermediate users in developing their Alpha Anywhere
and Alpha Five applications. While targeted at the average
user, experienced developers have told us our books have
gotten them up to speed more quickly than if they had ven-
tured out on their own.

The lessons are designed with step-by-step instruc-
tions. While each section may be used independently,
some of the terminology builds sequentially from chapter
to chapter.

The programs have even more features than we can
cover in our manuals. We invite the user to explore the
program by using the genies and the help file. The beauty

*. Alpha Five V11 users will find reports covered in Alpha Five Made Easy, The Basics and More for Version 11.
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ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
of the software is that it is so user friendly. Once you get
started, you will be amazed at the level of sophistication
you can achieve. 

Naming convention for lesson files
The included Alpha Anywhere / Alpha Five databases

contain sample and working tables, reports, etc. When the
exercise calls for you to create or open a file there is usu-
ally a corresponding completed example. 

• The exercises may call for you to create a file begin-
ning with “My,” such as MyColorForm.

• The exercises may call for you to open an existing a 
file ending with “Practice,” such as Color-
Form_Practice. 

• The completed examples do not have the “My” prefix 
nor end in “Practice,” such as ColorForm.

Troubleshooting tip: If you are having difficulty with
an exercise, compare your work with the completed one.

To quote or not to quote
Within Alpha Anywhere / Alpha Five, quotes have a

very specific use. To avoid confusion in the instructions,
we have not used quotes around text to be entered, but
have bolded the font instead. For example: Type My name
is Susan. 

Footnotes
In some instances, the footnote for a given page will

appear at the bottom of the following page. Location of
footnotes is set by our book writing software program
(Adobe Framemaker) and we have no control over where
it puts them!

Screen shots
For various reasons, the paths given in the screen shots

are sometimes different than the ones to which we refer in
the text. To avoid confusion, we have stricken out the
screen shot paths. Just follow the text for the proper path.

Checkboxes, OK and Dialogs
There are many instances where checkboxes will need

entries. Rather than saying, check the check box, we will
just say Yes or No. For example:

•Display ‘Print/Preview’ at runtime? Yes.

As you can well imagine, we say “Click OK” a gazil-
lion times. In order to save a few trees, we will attach it to
the previous step as in:

•5. Type in the file name: Clients. (Click OK)

Dialogs: We will indicate the changes that need to be
made in dialogs. Often there will be other options that are
not mentioned. In those cases, accept the defaults.

Using remote databases
One of the very impressive things about Alpha Any-

where / Alpha Five is that it allows users of SQL* and
other database file types to connect to their data. The data
remains in its original format, but now the software’s leg-
endary easy-to-use design features are available for every-
one. This book describes briefly how to use SQL with grid
components. For more information, see Alpha Anywhere
or Alpha Five Made Easy.

What you need to know
You will need a working knowledge of Alpha Any-

where or Alpha Five on the desktop. This book expects
you to already know how about tables and sets, fields and
field rules. You should know how to design desktop forms
and reports and create buttons. You should know how to
use the Expression Builder and how Functions are used
(we don’t expect you to be an expert in this area, but you
do need to have a basic understanding). You should know
how to use Action Scripting and have a sense of how
Operations work. You should know how to use the Proper-
ties Pane and Object Properties dialog, as well as the Tool-
box and DragDrop List. In short, you need to know the
topics covered in Alpha Anywhere Made Easy and the
Report Writer or Alpha Five Made Easy.

The equipment you will need to have
You will need to have Alpha Anywhere or Alpha Five

Version 11 installed on your computer. Information on pur-
chasing the program can be found at www.alphasoft-
ware.com. You may also contact Alpha Software, Inc. by
E-mail at (custserv@alphasoftware.com) or by phone at
781-229-4500 during regular business hours, Eastern
Time.

Alpha & Windows compatibility
At this writing, Alpha Anywhere and Alpha Five V11

are both compatible with Windows XP – Service Pack 3
(SP3 includes .NET v4, a V11 requirement), Vista, Win-
dows7 and Windows Server 2003. Alpha Anywhere is also

*. SQL = Structured Query Language. This is the format used by Microsoft Access and some other databases, as opposed to the DBF 
file format used by Alpha Five.
xi



INTRODUCTION
Installing the Lesson Files
compatible with Windows8. For complete and up-to-date
information, see www.alphasoftware.com.

Documentation
There is extensive documentation for the desktop
side of Alpha Anywhere / Alpha Five. Details on
using the help system can be found in Chapter 11

on page 311. Individual references are found at the end of
relevant exercises.

Videos
We have also included references to videos at
the end of the exercise. Look for the camera
icon. 

• Readers have asked that we also alert them in advance 
so they might watch the video and then do the exer-
cise. In most cases, Video! will appear at the begin-
ning of the exercise with the page number where you 
will find the camera icon that gives the location of the 
video.

Installing the Lesson Files

Note: The Alpha Five program is necessary to open the
lesson files.

• A. To install the lesson files from the CD:
a. Insert the Enhance Your Desktop App! companion 
CD-ROM in your CD drive. 

b. Open Windows Explorer and navigate to the drive 
with the CD.

c. Proceed as follows for the download edition.

• B. To install lesson files for the Download Edition”
a. Double click on the zip file and/or the .exe file to 
begin installation.
•Message reads: This will install the Enhance Your 

Desktop App! files to your hard drive.

b. Click OK.

c. Unzip to folder: c:\Alpha_EnhanceDesktopBook.

•This is the default folder. It may be changed, but 
please note that links in some of the completed 
examples may need to be reset.

d. Click Unzip.
•Message reads: Files unzipped successfully. 

e. Click OK.
•The Readme file opens.

f. After reading the Readme, close it.

g. Open the database as indicated below.

What files are included?
There is one database included with this book.

• ABC_EnhanceDesktop is the foundation for most of 
the exercises.

• Copies of the Alpha Anywhere / Alpha Five data-
bases, Northwind and AlphaSports are for remote 
database users. They are referenced in “Connecting 
your SQL data” on page 46.

• The PDF version of the book will be installed at 
c:\Alpha_EnhanceDesktopBook > Elec Edition.

Opening the database for 
the lessons
• To open the databases included with this book, open 

Alpha Anywhere / Five and navigate to the following 
file:

•c:\Alpha_EnhanceDesktopBook \
ABC_EnhanceDesktop \ ABC Seminars.adb.

•The .adb extension may or may not appear. 
Look for the file name with the tiny Alpha logo 
next to it. 

•File type = alpha5 Document.

•  Click on the Control Panel tab 
in the status bar at the bottom of the screen to 
bring the Control Panel to the front.
xii



 Chapter 1.

Beyond the Basics!

Time to make the box even better… 

No plain, boring database for you. This book will show you how to add just the right elements
for an amazing application. Enhance your forms and reports with images, charts, color and
style. Make data entry effortless and customize to your client’s content. And that is just a small
sample of what you’ll find around here. Enjoy!



Notes:

CHAPTER 1. BEYOND THE BASICS!

2

Important!

To open the databases included with this book, see “Preparation for the Les-
sons” on page 6.

Image on reverse: Copyright mills21, 2012 used under license from Shutterstock.com

Support

While every effort has been made to pro-
vide readers with a trouble free and accurate
learning experience, some errors are bound to
occur.

The support section of our website will
publish corrections as they are discovered. We
suggest you visit it periodically to see if there
are modifications for this book.

And please let us know if you find some-



ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
Welcome!

Welcome to Alpha Anywhere Enhance Your Desktop App! The subjects you
will find here will help you develop professional and sophisticated applications.
This book should be at your side while you are developing your own application
because the software has so many valuable features that it is hard to absorb them
all at once. This book will show you methods that you many not previously
have considered and will dig into details about others.

What’s in a name?
If you have been a long-time member of the Alpha family, you are likely to

be familiar with the name progression from Alpha Four to Alpha Five to Alpha
Anywhere. However, if you are a new user, it may be a bit confusing. I liken it to
my blended family. Those in the know can figure out the relationships – others
need a two page diagram. Here’s an Alpha Software history lesson.

ALPHA FOUR Alpha Software began back in the DOS days with its initial database product
called Alpha Four.

ALPHA FIVE The change from DOS to Windows required an entirely new way to develop
databases, hence the name change to Alpha Five. 

• Alpha Five Versions 1 - 11 were sold as independent entities.

ALPHA ANYWHERE In time web design was added to Alpha Five’s capabilities. Then along came
smart phones and tablets, creating the mobile era. Alpha Software immediately
jumped on board. In 2013, the name was changed to Alpha Anywhere to more
fully describe the versatility of the product.

• Alpha Anywhere is sold by subscription.

All of that seems fairly straight forward, except that Alpha Five V12 remains
the engine for Alpha Anywhere. That is why you will find the program files for
Alpha Anywhere in the c:\ Program Files (x86) > A5V12 \ directory.

It also explains why Alpha Anywhere is not version specific. In other words,
even though the most recent release is promoted as Alpha Anywhere 3.0, it is
still powered by Alpha Five V12. And. because it is sold by subscription, the
versions just meld one into the other. 

REFERENCES The above is important to know because it means that what works in Alpha
Five also works in Alpha Anywhere. 

•Certain file names still begin with A5 and certain dialogs still say 
Alpha Five, even when you are working inside Alpha Anywhere. And 
many documentation pages and videos also refer to Alpha Five.

We will use the reference in existence at the time of the writing of the book.
It may be changed by the time you see it. Just remember that Alpha Five and
Alpha Anywhere are the same entity. Only the names differ.

IMPORTANT NOTE Since this book is compatible with both Alpha Anywhere and Alpha Five
V11, we will refer to the software as AA/A5 or Alpha.
3



CHAPTER 1. BEYOND THE BASICS!
Welcome!
Companion book
Enhance Your Desktop App! is the second book in our series of using AA/A5

on the desktop. The title of the first will depend on the software version you are

using.*

•AA: Alpha Anywhere Made Easy, The Basics and More.

•A5: Alpha Five Made Easy, The Basics and More for V11.

For simplicity’s sake, we may refer to the above books as:

•Alpha Anywhere / Alpha Five Made Easy or

•Alpha Anywhere and/or Alpha Five Made Easy.

What you need to know
While this book is independent of the above publications, it does presume

that you know how to use the software. You should already know about data-
bases, tables, field rules, sets, forms, embedded and stand-alone browses,
reports, operations, how to create buttons and use Action Scripting. If you need
more information on these topics, we suggest you become familiar with the

material in the above books before you embark on the exercises in this one.† 

What’s in this book…
AA/A5 has two types of forms, standard desktop forms and web forms.

Because it will be new to many of you, we will first show how to create a web
form that can be used on the desktop. We will then move on to ways to enhance
the standard forms with Action Scripting, charts, conditional color, Stylesheets
and many more marvelous methods.

Finding and filtering records is discussed in detail, as are data controls.
Images are a large part of our world today and we will show how they can be
used effectively. Custom menus, toolbars and bubble help will make your appli-
cation even more useful and unique.

And let’s not forget reports, another mainstay. We will show how to enhance

them with charts and conditional color and even put one on a form.‡ We’ll wrap
up with the built-in e-mail system. 

All these extras will give your application the functionality and fine appear-
ance that it deserves. And we will do it all without a line of code – well almost.
In the one small instance where Xbasic is required, we even supply it for you.
Here’s a chapter by chapter breakdown.

WEB WONDERS DAZZLE 
DESKTOP!

In the web/mobile world, Alpha is revolutionary. It is far more than a data-
base software program, it is a development environment that can be used by
novice and expert alike. One of its signature pieces is the “Grid” component that

*. Both books are by Susan Hussey Bush and are available at www.libertymanuals.com

†. If you are using AA/A5 with SQL, we will show you how to connect to your data, but the full benefits of using them together on the 
desktop are described in Alpha Anywhere and Alpha Five Made Easy.

‡. This is included for A5V11 users because it is not covered in Alpha Five Made Easy. Alpha Anywhere user will also find more 
information on this topic in the Alpha Anywhere Report Writer.
4



ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
provides a point and click way to design forms that can be viewed on the Inter-
net. Another type is called the “UX” (User Experience) Component.” While we
do not cover the UX specifically here, it can be used on the desktop in the same
manner as the Grid component.

Standard desktop style forms cannot be used on the web because everything
must pass through a browser – Internet Explorer, Firefox, etc. Regardless of the
database program that creates them, these forms cannot meet the browser
requirements. Since the desktop form cannot go to the web, the folks at Alpha
Software brought their web forms to the desktop. 

So you can see how great grid components are on the desktop, we start right
out with a quick demo – after which, we expect you will be champing at the bit
and wondering how to create one of these marvels and add it to your desktop
app!

• Then it’s back to the desktop side.

PICTURE PERFECT! How many times have you heard it said that a picture is worth a thousand
words? Your users will be impressed with images and go gaga when you add
Google! And let’s not forget about charts. Another winner, for sure!

DATA ENTRY MADE EASY! Forms are all about data entry, so it’s important to know which tool suits the
job – do you need a drop down lists or radio buttons or a spin control? Learn
which to use when. Then its time for a fun exercise that shows how to jump
from the data in an embedded browse to a form with some fascinating features!

RADICAL REPORTS! Reports can have personality, too. Since printing to PDF is almost as import-
ant as printing to a printer, color has become a consideration and so have book-
marks. Headers and footers are not old hat when you know how to use them.
And there’s more to munch on!

FIND IT! SORT IT!
FILTER IT!

Finding and filtering data is one of the primary needs in a database and AA/
A5 is loaded with tools that get the job done. This chapter will help you sort
them out and choose the most apt for your application!

EXPERIMENT WITH 
XBASIC AND XDIALOG!

Learn how Variables and Xdialog can take your application to new highs.
Don’t be scared – we make them child’s play!

CUSTOMIZE YOUR APP! Tweak your application with custom menus and toolbars, add a dialog that
shows the progress of a long script and toss in some really special bubble help.
Be sure to take this car for a drive!

HOT COLOR AND 
COOL STYLE!

Up! Up! Up! Take your desktop forms to the sky with the right color scheme
– and keep it consistent with sophisticated Stylesheets.

EXCITING E-MAIL AND 
EFFICIENT FAXES!

How did we live without e-mail? Click a button to send a confirmation in
seconds. Fax a report from your computer. Make mass mailings a part of your
marketing methods!

HEAVENLY HELP PLUS We put this chapter in every book because it is so important. If you have yet
to use the Documentation and Video buttons that can be seen when the Control
5
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Panel is displayed, be sure to go to page 311, even before you begin the exer-
cises. 

And, even if you have used it before, be sure you are familiar with the
updated Video Finder that is described on page 324.

• Ready to dig in? Begin with these basics!

Preparation for the Lessons

Chapter 2 uses the “web side” of AA/A5. the others use the “desktop side.”

Opening the database for the exercises
The exercises in the following chapters are based on a database included

with this book.

• Open AA/A5 and navigate to the following file:

•c:\Alpha_EnhanceDesktopBook\ABC_EnhanceDesktop\ABC Seminars.adb

•  Click on the Control Panel tab in the status bar at the bottom 
of the screen to bring the Control Panel to the front.

Object Properties Instructions
Alpha has two places at design mode for setting the properties of objects

(fields, labels, etc.) on a layout (form, report, etc.), the Properties Pane and the
Object Properties dialog. We will use one or the other, depending on the situa-
tion. Our instructions will use the following format to identify the settings and
where they are located.

• If the Properties Pane is not visible at Design mode, go to Top Menu > Task List > 
Properties.

PROPERTIES PANE The Properties Pane consists of the following attributes:

•Name of object: CLIENT_ID (yellow).

•Various Categories, such as Border (pink).

•Formatting and definition options, such as Color (aqua).

Here’s how the instruction will read:

PROPERTIES PANE: CLIENT_ID

BORDER Color: Red
6
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OBJECT PROPERTIES
The Object Properties dialog contains the same definitions as the Proper-
ties Pane, with the exception of Dynamic properties. It also has unique
definitions and sometimes its graphic interface makes it easier to spot
what you’re looking for and/or visualize the results.

Object name: Note that the object name is reported at the top of the dia-
log and at the Setup tab. It can be changed here as well as in the Proper-
ties Pane.

•In this case, the name of the tab will appear at the left instead of the category. 
F12 is the Hot Key that opens the dialog.

OBJECT PROPERTIES (F12): : AMT_DUE

FORMAT •Display Format: Width 17; Decimal places 2.

•Format Style: 123,456.78.

Don’t miss out!
In case you’re the type that skips the Introduction, be sure you review:

•“Getting Started” on page x.

And by all means check out:

•“Heavenly Help Plus!” on page 311.

At the end of most chapters, you will find references to our other books so you
can be sure not to miss even a minute morsel of our compelling content!
7
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 Chapter 11.

Heavenly Help Plus!

Ordinary help is old school …

AA/A5 help is one of the best we’ve seen. It puts the extraordinary number of
help topics and videos at your fingertips. 

The newly revised Video Library makes it super easy to find just what you’re
looking for. Definitely a plus!
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312

What you’ll find here…

Topic Page

“How the Chapter is Organized” 313

“Understanding the Documentation Viewer (DV)” 314

“Getting off to a strong start” 314

“Display and navigation” 314

“Searching for topic pages” 316

“Saving page references” 319

“Taking notes” 320

“Printing topics” 322

“Updating the documentation” 322

“Window style” 323

“Restoring open pages” 323

“Sending feedback” 323

“Using the Video Finder” 324

“Filtering” 324

“Refreshing” 325

“Preferences” 325

You may have seen this chapter before because we add it to almost all
our books – it’s that important!

But. Don’t run off. There’s new information on using the Video Library, so
be sure to look it over (page 324).



ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
How the Chapter is Organized

Being able to get assistance as you work is essential to using any feature
laden program like AA/A5. The good news is that there is so much documenta-
tion. The bad news is that there is so much documentation because the sheer
volume can be overwhelming.

Fortunately, the Documentation Viewer (DV) and Video Finder (VF) will get
you where you want to be. These are both opened within AA/A5.

You can:
•Add notes to any topic.
•Print a single page or multiple pages to a PDF document. 
•Save to lists. 
•Search for topics by keyword, full text and multiple criteria. 
•Update topic pages with the click of a button.

And. Much of the help system can be used without an Internet connection. That
means you can keep working on an airplane or other non-Internet location.
There are two exceptions, however:

•DV: Images do require an Internet connection at first, but are cached 

locally once a topic has been viewed.1

•VF: You will need an Internet connection to view the videos.

The Documentation Viewer and Video Finder will find all the references
seamlessly – and you won’t even have to leave the AA/A5 environment. The
Documentation and Videos buttons are on the main toolbar and are available at

either the Web Projects Control Panel or the Control Panel.2

WHERE DO I LOOK? The Video Finder is the first place to look for web and mobile coverage. The
Documentation Viewer also contains many useful pages, so be sure to go there
for additional information.

Why Plus? You may be wondering why we entitled this chapter Heavenly
Help Plus. The answer is that there’s been an improvement to the Video Finder
that you will really appreciate. Finding videos is easier than ever, now.

1. See “Image display” on page 314.

2. As we go to press, the Videos button is not in the latest software update, so you may not be able to see it. If that is the case, go to Top 
Menu > Help > Video Finder. We have been advised that the button will appear in the next release. SHB 10.5.2012
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Understanding the Documentation Viewer (DV)

The Documentation Viewer and Video Finder are separate systems. Since
there are so many documents on so many topics, it has a more complex struc-
ture. 

Getting off to a strong start
We recommend you watch the following videos to learn how to use the Doc-

umentation Viewer. Our notes will be available for a quick refresher, but they
depend on your having watched the videos. It will be 20 minutes well spent –

promise!1

1. Open AA/A5.

2. Click the Documentation button on the main toolbar.
•Once it opens, the DV has its own toolbar (shown below in two sec-

tions).

3. Click How to use the Documentation Viewer (far right).
•The Documentation Viewer page opens. It gives a list of the features 

and has 4 videos. You may need to scroll down to find them.

•Video Part 1: Overview, Navigating, Filtering.

•Video Part 2: Filtering (cont), Saving Lists, MDI & Modeless views, 
Properties.

•Video Part 3: Synchronize with 2 monitors, Browser-like experience, 
Links to Wiki, Printing to PDF.

•Video Part 4: Favorites, Annotating help documents (Notes).

• Now that you have watched the videos, you know how the system works so 
please read over the rest of this chapter. You can come back here for the set-
tings as you need them.

And. We have included additional information that you will find valuable.

Display and navigation

IMAGE DISPLAY We mentioned earlier that the DV can be used without an Internet connec-
tion. This is true for the most part. One exception is that, the first time a page is
displayed, an Internet connection is required in order to see the images.

• Once the page has been displayed with an Internet connection, the images 
are downloaded from the server and cached locally. Therefore, the next time 

1. Sorry if I sound like your mother here - but, you gotta to do your homework - now! SHB
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that particular page is opened, the images will be displayed even when you 
are not on-line.

ENLARGING THE VIEWING 
AREA

There are two ways to give more room on the screen.
•Width: Do this give more width to the topic pages:

•Click the Show/hide Selector button on the toolbar to close the left 
panel.

•Height: If you have a document or list that is very long, it can some-
times be difficult to see the bottom of the scroll bar. Solution: Close 
the tabs at the bottom of the window.

•Top Menu > View: Turn off Window Bar.

OPENING PAGES Topic pages are opened by selecting an item from the left pane.
•One click open: Each time you select a topic in the list, its page is 

opened in the right pane.
•Viewing open pages: When 

you have a lot of pages 
open, do the following:

a. Click the arrow at the 
right side of the tabs for 
a list (red circle). 

b. Select the page.

c. Click OK.

•One page is always open. The system requires that at least one page 
be open at all times. To close unwanted pages, see “Closing pages” 
below.

NAVIGATING As you saw in the video, it is easy to get around using the back, next, up and
down arrows. 

•Back and next arrows: Moves back and forth between pages.
•Up and down arrows: Moves up and down on the list.

•When you use these to move to a new topic in the list, the page is also 
opened. Handy for opening a group of pages that are listed sequentially.

CLOSING PAGES You can close an individual topic page or several at a time.
•Closing selected pages: When you have a lot of pages open, do the 

following:

a. Click the arrow at the right side of the tabs for a list (red circle 
above). 

b. Select the pages you would like to close. 

c. Click Close selected topics.

•Closing a single page. 

a. Right click on the tab and 
choose Close this Tab.
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•Closing all except current page:

b. Select the page you want to keep open.

c. Right click on the tab and choose Close all but this tab.

BREADCRUMBS Breadcrumbs show where the page is located within the AA/A5 Wiki struc-
ture. By default, you will find them at the top of the topic page as below. You
may turn them off or have them appear elsewhere, if you like.

We recommend you keep them on, at least in the beginning, because they can
be handy for navigating upwards in the structure. In the example below, you
could click on References or Functions for additional references. 

We suggest you experiment. Sometimes the links are useful, other times not.

a. Preferences > Show topic path: 
Yes or No.

b. Preferences > Topic path posi-
tion: Choose: Above, Below or 
Above and Below.

Searching for topic pages
There are several ways to find documents. You can search by page title, by

text in the topic, or use multiple criteria. Other aids include the Table of Con-
tents and Search Results tabs. If you have a second monitor, you will be inter-
ested in synchronized searching. We have also included notes on using help
inside the Expression Builder.

FILTER BY TITLE Finds all occurrences in the document title.

a. Type: Choose Filter (red circle below).

b. Enter trim in the filter box.

c. Select TRIM Function.

•Trim() will not return any 
results because the title of the 
page is TRIM Function (pink), 
not TRIM() as you might 
think.

• Now, let’s see what happens when we change to full text search.

FULL TEXT SEARCH Finds every occurrence of the entry – full or partial word, highlighted in red.
•When you select Full text search, a Go button appears.

a. Type: Click Full text search (gold 
arrow).

b. Click Go (red circle).

•Alpha automatically opens the 
Search Results tab.
•Returns 204 pages.

c. Select a document and scroll to see the 
highlighted text.
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MULTIPLE SEARCH 
CRITERIA

Finds instances of up to five designations. Results are shown in the Search
Results tab as above.

•Wildcards * and ? are permitted, such as SQL*Select*Statement (finds 
only records with all entries). 

•Found text is highlighted in red as above.

a. Click the Search button on the toolbar.

b. Enter trim and cdate in the first two boxes.

•The expression is returned at the bottom of 
the window (pink).
•Finds documents that contain both criteria.

c. Click OK.

•The search begins immediately.
•13 documents are returned at the Search 
Results tab (inset).

d. Click Search again.

e. Enter trim or cdate. (Click OK)

•Click And and change to Or.

•Finds documents that have either trim or cdate.

•This time 213 documents are returned.

f. Inspect a few to see how selections were made.

Now would be a good time to experiment with some more searches so you
get a good sense of how everything works. Will save you time down the road.

TABLE OF CONTENTS TAB The Table of Contents tab shows the search criteria in a tree format. We
entered grid component in the Filter to get the result below. 

•Drilling down the various sections, opens the page references.
•The TOC can be useful for finding topics in a very long list.
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•When a topic is selected in the TOC, the selection is refelected in the 
Topic List (inset) and vice versa.

SEARCH RESULTS TAB Each time you do a Full text or Multiple criteria search, the results are dis-
played in the Search Results tab. 

•When you first open the DV, there is no Search tab.
•When you do a Full text search or use the Search button for multiple 

criteria, the tab is automatically opened and the results displayed.
•Each new search replaces the previous one.
•When you close the DV, the search contents are cleared.

SYNCHRONIZED SEARCH Video #3 explains Synchronized Searches very well so we’ll save a few trees
and skip it here except to note that, if you are in the process of learning Xbasic
and/or are serious about writing code and don’t yet have a second monitor, this
just might be the time to get one.

a. To turn it on, click Preferences on the toolbar.

b. Synchronize help on current function: Yes.

•Default = No.

FUNCTION HELP IN THE 
EXPRESSION BUILDER

When writing expressions in the builder, you can get function help by press-
ing F1 or clicking Help on Current Function. This will bring up the Documen-
tation Viewer page. If you only have one monitor, you will need to close the
page before continuing with the expression. 

Here’s a work around for keeping the page open.

a. At the Expression Builder, place the cursor in 
the middle of the Function (upper).

•The full function, complete with the 
opening parenthesis, needs to be entered in 
order for this to work. Just begin typing 
and pick it from the suggestions.
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b. Click the Help on Current Function button or 
press F1.

HOW EB HELP WORKS
The Expression Builder is opened in a
“modal” window. That means you can’t
move to another window when it is open.
When you go to help from within the EB, the
Documentation Viewer opens in yet another
modal window that must be closed in order to
continue.

KEEPING FUNCTION HELP OPEN
If you would like to keep Function Help open
while you continue to work in the Expression
Builder: 

c. Click the link at the bottom of the DV page 
(yellow) to open the document in the Wiki.

•You can then work back and forth between AA/
A5 and the page in the Wiki.

Saving page references
You can save page references so you can return to them quickly. There are

two ways, Favorites and Lists. The first is a simple listing of pages, the latter
groups multiple pages.

FAVORITES It’s quick and easy to save your frequently used topics in Favorites. At this
writing, topics are added in the order saved – most recent at the bottom – and
there is no way to group or alphabetize them, so a long list could become
unwieldy. Keep Favorites short and use Lists (below) for more lengthy topics.

a. Filter: Enter trim.

•5 topics are returned.

b. Select a topic in the list: Right click > 
Add to Favorites.

c. Go to the Favorites tab to see the entry 
(green).

LISTS Lists are great for saving groups of pages. The important thing to remember
is that they save the open pages – not items in the Topic List (see screen shot
below). 

a. Filter: Enter trim.
319



CHAPTER 11. HEAVENLY HELP PLUS!
 Understanding the Documentation Viewer (DV)
•5 topics are returned.

b. Click the last topic in the list.

c. Right click on the Trim page and select Close all but this tab.

SAVING

a. Click Save the current list of 
open topics … on the toolbar (red 
circle).

b. Name of list: Trim.

c. Click OK.

RETRIEVING a. Click Open a previously saved list of topics (red circle).

b. Select Trim.

•Note that Topics in List contains only the open page (inset above).

ADDING PAGES Pages can be added to a list. This operation overwrites the existing list. In
order to add pages, you need to open the original list first.

a. Click Open a previously saved list of topics.

b. Name of list: Choose the List. (Click OK)

•The original pages in the list are now open in the right pane.

c. Open the new pages you want to add.

d. Click Open a previously saved list of topics again.

e. Name of list: Choose the List.

f. Click OK.

•Alpha recognizes that you have changed the list and asks if you 
want to overwrite.

g. Overwrite existing list? Click OK.

DELETING PAGES Pages can be deleted in the following manner.

a. Click Open a previously saved list of topics.

b. Name of list: Choose the List. 

c. Click Edit List at bottom of dialog.

d. Delete the pages you want to remove.

e. Click OK twice.

Taking notes
Notes are well described in Video #4. Here are the settings and some addi-

tional thoughts.

ADD NOTE TO EXISTING 
PAGE

You can annotate any page. Depending on where you have located the notes,
these may or may not be shared with a work group (see “Notes directory” on
page 321).

a. Enter trim in the Filter box.
320



ALPHA ANYWHERE ENHANCE YOUR DESKTOP APP!
More Desktop Features Made Easy
b. Select TRIM Function.

c. Click Notes on the toolbar.

d. Choose Add / Edit notes for this topic.

e. Enter: The Trim function is good, but All-
trim is better. Add your initials and the date.

f. Click OK.

•A User Notes link is added to the top right 
of the page (aqua).

g. Click User Notes.

•Jumps to the notes at the bottom of the page (yellow above).

CUSTOM TOPICS You can create your own topic pages. They can be found as any other
AFTER you close and reopen the Documentation Viewer.

a. Click Notes on the toolbar (screen shot above).

b. Choose Add a custom topic.

c. Specify the name of the topic: MyCustomTopic.

HINT! Choose a naming convention for these pages in advance. For example, start
them all with “My.” It will help you locate them later. You could also add them
to the Favorites tab or create a List for them.

d. Enter your information in text or HTML format. (Click OK)

RETRIEVE Do the following to retrieve the page:

a. Close the Documenta-
tion Viewer and reopen.

b. Filter: Enter the topic 
name: MyCustomTopic.

•The page is found and 
identified as a User Topic 
(red circle and yellow high-
light).

EDIT There are two ways to edit custom topics. 
•Topic page: Click Add note (gold arrow above).
•Toolbar: Click Notes > Manage Notes > Edit Note (screen shot 

below).

DELETE After you create the custom topic, a new item is
added to the Notes menu.

a. Click Notes > Delete topic.

b. Confirm deletion.

NOTES DIRECTORY To identify and/or change the directory where the Notes are stored, go to:

a. Preferences > Table for user notes: Click to Define.
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b. Choose SQL or DBF.

c. Complete dialog as indicated.

•Be sure to read notes about sharing across the workspace and/or 
creating tables.

Printing topics
Printing is done to a PDF file which you can then print out if you like. You

can print a single page or combine multiple pages into a “book.”

SINGLE PAGE a. Select the page you want to print from the right pane.

b. Click Print on the toolbar.

•If only one page is open, printing will begin immediately.

•If more than one page is open:

c. Click Print > Print current topic.

•PDF document will be opened in Adobe 
Acrobat.

MULTIPLE PAGES Printing multiple pages will result in a PDF document with a Table of Con-
tents and Bookmarks.

a. Open the pages you want to print.

b. Click Print > Print selected topics (screen shot above).

c. Choose the topics individually or use the hyperlinks at the 
bottom of the dialog to do one of the following:

•Select All, Un-select All, Wildcard Select.

d. Click Wildcard Select to see how it works.

e. Click Select All. (Click OK)

f. Click OK.

•Documents are printed in alphabetical order.

•The PDF document is opened.
•Note it has been saved as an a5_temp file (top of 
window).

g. File > Save As: Rename and save in desired loca-
tion.

Updating the documentation
From time to time, the folks at Alpha update or add pages and remove out-

dated material, so you should refresh your local content periodically. There’s a
reminder for that.
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REFRESH ALL TOPICS Refreshing all the topics takes only a few moments. 

a. Click Refresh help topics on the toolbar.

•Alpha checks the server for revisions and 
returns a notice of the action taken. In this 
case, our topics were all up to date.

b. Click OK.

•You are then notified that the DV will be 
closed and reopened.

c. Click OK.

REFRESH A SINGLE TOPIC You can refresh a single page, if you like.

a. Topic List: Select the page.

b. Right click > Refresh topic from server.

SETTING A REMINDER You can have Alpha remind you to refresh topics when you open the DV.

a. Preferences > Display reminder to refresh documentation every: 
Enter number of days.

•Default - 14 days.

Window style
You can have the window appear as MDI or Modeless. This is well illustrated

in Video #3. 
•MDI allows you to move from window to window. Recommended for 

use with single monitor. Default.
•Modeless means that you are “locked” in the window until it is dis-

missed. Good for users with dual monitors.

• The setting is located at:

a. Preferences > Window style.

Restoring open pages
You can specify whether or not you want Alpha to restore the most recently

used tabs upon opening the DV. You can also set the maximum number of tabs
to restore.

• The setting is located at:

a. Preferences > Restore tabs on startup: Choose Yes or No.

b. Preferences > Maximum number of tabs to store: Enter number.

• Default = 20.

Sending feedback
There is a button at the bottom of each document that will open a window

where you can submit comments on the topic directly to Alpha Software.

a. Select the document, scroll to the bottom and click Send Feedback.

b. Enter notes, your email, etc.
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c. Click Send Feedback.

•A Notice is returned with an ID number.

d. Make note of the ID number for future reference. (Click OK)

NOTE This feature is not available if you add notes (page 320) to the topic page. 

Using the Video Finder

After all that work on the Documentation Viewer, this section is going to be a
piece of cake!

AA/A5 has a wealth of videos, most of which are for web/mobile. They are
easy to follow and you will find them extremely helpful. Each is identified by
Number, Category and Description. Some of the numbers have prefixes, as M38
below. Others do not. Even though many created for earlier versions, they are
still applicable.

1. Open AA/A5 and click Videos on the main toolbar.1

•Available at Web Projects Control Panel and Control Panel.

2. Enter a Filter.
•The Category list comes up, with the number for each listed at the left 

(in parenthesis).

Filtering
At this writing, only simple searches are available. There is no provision for

“and,” “or,” etc. That is on the Alpha “to do” list, however, so keep an eye out
for a Search Syntax hyperlink next to the filter box.

1. If you don’t see the Videos button, go to Help > Video Finder. The button is coming soon – promise!
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Refreshing
Just as with the DV, you will need to refresh the video content from time to

time. You can do it manually or add it to your preferences (see below).

Preferences
You can define the Window style and set an automatic update.

3. Click Preferences on the toolbar.

WINDOW STYLE There are two window style options, MDI and Modeless.

a. Choose MDI (default) or Modeless.

•MDI: This is the standard view (default). Recommended if you 
are using a single monitor. (See below for wide screen monitors.)

•Modeless: If you are using two or more monitors, you can drag 
the VF window to one of them and keep it open while you are 
working. This also works if you have a wide screen monitor and 
want to place the AA/A5 workspace on one side and the Video 
Library on the other.

MODELESS WINDOW 
STYLE

If you choose the Modeless style, a Menu button will automatically be added
when the screen is too narrow to display both the categories and the video list.

• When the Menu button is clicked, the category list slides out on top of the 
video list (yellow below).
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CHAPTER 11. HEAVENLY HELP PLUS!
 Using the Video Finder
Do you recognize the Docked Panel? Of course you do. We learned all about
them at “Building a Menu with Docked Panels” on page 275. That leads us to
one of the more interesting aspects of the new Video Library – it was built using
the List Control! Watch the video below to learn all about it.

AUTOMATIC UPDATE If the number of days since the last time the Video Library was updated is
more than this number of days, the Video Library will be updated automatically
when the Video Finder is loaded.

b. Automatically update Video Library every 5 days. (Default)

•Set to 0 to turn off automatic updates.

4. Click OK or Cancel to close the Preferences dialog.
•If you make a change and click OK, the Video Finder will be closed 

and reopened to make the change.

Can you believe that’s all there is to Video Finder? We’re done!

GO TO ALPHA VIDEO See how the Video Finder was developed with the List Control.

• Videos > Filter: Enter Video Finder. Choose:

•VF_V12-1. Finding Videos in the Video Library.
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